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GPS for Historical Mapping 

 
Garmin GPSMAP 64st 

 

Introduction 
 

Historic record keeping is greatly enhanced if precise location information can be included. Locations of 

buildings, roads, railroads, trails, cemeteries, and other details of historic interest are being lost with 

time. Even the locations of abandoned towns and cities are fading from memory. Tools are available to 

document these locations and even help find lost sites. 

Obtaining accurate Latitude and Longitude values for historic mapping purposes now (2018) is relatively 

simple and inexpensive. Even what might be considered recreational grade portable GPS units typically 

provide accuracy of better than 10 feet (3 meters). That is with GPS units in the $200 to $400 range.  

While an accuracy of plus or minus 10 feet is not adequate for legal property line surveys and such, it is 

adequate for documenting the location of a cabin, entrance to a cave, or other point of interest for 

future reference. Most of these GPS units can also log their movement along a track. Point and track 

data is easily transferred between GPS units and computer mapping programs for further processing. 

An accuracy of better than plus or minus 10 feet is typically regarded as map grade accuracy. For normal 

cartographic purposes, greater accuracy is unnecessary. Survey grade GPS units with plus or minus 3 
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foot (1 meter) accuracy are typically 10 to 100 times as expensive as the map grade units. Survey units 

are typically used to mark locations within an archeological site. 

An added plus in this modern recreational grade GPS equipment is that it is designed to be used by 

ordinary people. No special technical knowledge or training is necessary. Of course, some initial 

familiarization and practice is necessary as with any new non-trivial technical item such as a smart 

phone. However, that familiarization period is short with these GPS units. 

Once data has been collected with a GPS unit, it must be preserved and presented in ways useful for 

research purposes. Inexpensive PC and Mac software is available to satisfy most of those needs. 

Actually, much of historic research requires little elaborate map data processing. Often site sketches and 

location descriptions are all that are needed with GPS Latitude and Longitude data supplied in footnotes. 

Formal mapping is usually a matter of passing a location and track data to professional cartographers. 
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GPS System Review 
 

 
US GPS Satellite Constellation 

Most people today are aware of GPS and may have some idea of how it operates. That subject is 

mentioned here as more of a quick review. Some knowledge may help users to achieve the best 

performance out of their GPS units. A degree in satellite technology is not necessary. 

GPS is a satellite based system. A GPS hand held receiver monitors time and position information 

transmitted by GPS satellites. There are 24 active GPS satellites orbiting the Earth at an altitude of about 

12,500 miles. The position and timing of those satellites is arranged so as to provide continuous multi-

satellite ground coverage. That non-trivial satellite orbital coordination and satellite systems control is 

handled by the US Air Force.  

The Russian Space Agency has made their GLONASS satellites available for civilian use. The GLONASS 

system is similar in operation to the US GPS system, with its satellites orbiting at a slightly lower altitude. 

Newer hand held GPS units often include the ability to use both GPS and GLONASS systems at the same 

time. 

Satellite transmission paths to the ground are typically slightly shifted by the ionosphere and lower 

atmosphere. That shift is somewhat random and limits direct satellite position accuracy. To overcome 

this, the GPS system includes a set of ground stations monitoring the signals from the satellites. Those 

ground stations are able to calculate corrections for atmospheric conditions. Those corrections are 

transmitted by the GPS system Wide Area Augmentation System (WAAS) satellite and used by GPS 

receivers to provide +-3 meter (10 ft.) accuracy. In general, accuracy for continental North and South 

America is better with GPS and WAAS only. Adding GLONASS degrades accuracy in some situations. 

To obtain a Latitude/Longitude position fix on the ground, a minimum of three satellites in view is 

necessary. A fourth is needed if altitude is to be determined. Modern GPS receivers are able to select 

among the satellites they are receiving to choose those with the best geometric alignment to achieve an 

accurate fix. Six or more satellites may be used simultaneously to provide further reduced position 

error. 
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To obtain the best accuracy for a location, having a clear view of the sky, preferably from horizon to 

horizon, is helpful. It is best to hold the device up at shoulder height when marking a location or 

recording a track. The newer GPS units will still work well when carried in a pocket or on a hip belt but 

holding it high and in the clear will provide the most reliable results. 

 GPS receivers do not transmit. They are receive only devices. They are safe to use around other 

sensitive electronic devices. There are walkie-talkie/GPS receiver combinations and satcom/GPS receiver 

combinations but you pay extra for those devices. Most smart phones include a GPS receiver chip to 

determine its location but it is not that chip that sends that information out to the world. 
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Hand Held GPS Devices 

 
Garmin hand held GPS devices (35t and 64st models) 

There is several manufacturers of hand held GPS devices. Of them, Garmin is, by far, the leader. They 

provide the widest range of products and have the widest 3rd party support. Their equipment is reliable 

and reasonably priced. Garmin is probably the ‘safe’ choice for a recreational grade GPS device to be 

used for historical mapping. 

Most current Garmin GPS units are compact and touch screen operated. They are convenient for casual 

use as they may be slipped into a shirt pocket until needed. However, touch screens are subject to 

smudges and scratches if used in dirty environments. A button operated unit such as the Garmin 

GPSMAP 64st holds up better in rough or dirty conditions and is much easier to use with gloved hands. 

Both have the same screen size and resolution. Overall, the GPSMAP 64st is the favored workhorse unit 

for field GPS work. 

However… your specific use may favor the use of a touch screen unit. Field entry of text to label 

waypoints and to take notes is easier with the touch screen model. Usually though, field mapping work 

is labeled and annotated back in the office from short notes taken while in the field. 

Discussions from this point will center on the GPSMAP 64st. Overall operation is quite similar between 

hand held GPS though menus and key input sequences vary. Attempting to cover more than one GPS 

device at a time would likely prove more confusing than helpful. 

Operating a new hand held GPS unit for the first time may seem a bit overwhelming. The small display 

size limits the amount of text that can be displayed so some things might appear rather cryptic. To 

confuse things more, there are usually many options and features that you will likely never use. Don’t be 
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too frustrated as most of it will become familiar with a few hours of use. These units are designed for 

use by the general public so are difficult to damage by playing with options and settings. It is easy to set 

the unit back to factory default settings if necessary. 

 

For historic field mapping purposes, the operations needed from a GPS device are: 

1. Determine exact current location. 

2. Save the current location latitude and longitude for future reference. 

3. Save a track of the movement of the unit along a path or road. 

But the GPSMAP 64st includes these additional features/functions: 

4. Preloaded 100K topographic map of the entire US. 

5. 3 Axis compass. 

6. Altimeter. 

7. Calculator. 

8. Alarm clock. 

9. Calendar 

10. Stopwatch. 

11. Sun and Moon rise and set times. 

12. Route planning and direction. 

13. Waypoint proximity alarm. 

14. Geocache listings. 

15. Transfer waypoints, tracks, and other info to/from another 64st. 

16. Bluetooth operation with smart phone. 

17. Etc. 

Fortunately the GPSMAP 64st is configurable so that you can easily do the things you would like without 

having to dig past things that you don’t care about. Even more convenient is that you can have more 

than one operational profile with different configurations and easily switch between them. 

Again, while the feature set may vary from model to model and brand to brand, such flexibility is not 

unusual. Newer generations of GPS gear will likely be even more feature rich. Fortunately, those 

changes will be incremental so learning your first GPS device will equip you well to adapt to the next 

one. 

One point should be emphasized. Hand held GPS unit CANNOT be used for legal property boundary or 

landmark marking purposes. Legal surveys may only be performed by licensed surveyors. Their job is 

much more complex, involving use of legal benchmarks and property descriptions. However, for finding 

and recording the location of points of historic interest, modern hand held GPS units are generally more 

than adequate. Future historians can use that information to return to a location with confidence that 

they are within about 10 feet of where you recorded it.  
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GPSMAP 64st Main Pages 
 

Once you power up your GPSMAP 64st and its boot sequence completes there are some steps that will 

help getting your unit ready for field operation. The supplied sequence of display pages is likely a wild 

guess on the part of Garmin as to what a user might want to see. You can see their initial choices by 

repeatedly pressing the PAGE button while watching the entries on the horizontal ribbon that scrolls 

through the middle of the page. Stop pressing the PAGE button if you want to see what a page looks 

like. 

Page Sequence 
What you can do is to change that page selection to something more appropriate for your use. That is 

done by stopping on the page labeled Main Menu. Scroll up or down in that menu to find the entry 

labeled Setup and select it by pressing the ENTER button. In that menu, scroll up or down and select 

Page Sequence. 

The Page Sequence page allows you to add, move, or remove entries from the page select sequence. A 

reasonable beginning list of pages is: 

 Satellite 

 Map 

 Compass 

 Track Manager 

 Waypoint Mgr 

 Main Menu 

To add a missing entry, scroll down to the entry labeled Add Page and press ENTER. You will be 

presented with a list of potential pages. Scroll up or down to highlight the entry to be added and press 

ENTER. 

To remove an entry from the list, scroll up or down to highlight it and press ENTER. Select Remove and 

press ENTER. Removed pages will show up in the Add Page list so are not actually lost. 

You may use the Move option to adjust the sequence the pages will be display when the PAGE button is 

pressed. 

Once you have finished adjusting your page list, press the QUIT button a few times to exit the Page 

Sequence and Setup menus. 

Individual Page Adjustments 
Most main pages have configuration options. There are some that will be helpful. 

Satellite: This page shows which satellites the GPSMAP 64st is able to receive and their signal strengths. 

Press the MENU button while viewing that page. There are two entries on that list that are of interest. 



11/24/2018 GPS for Historical Mapping Spangler, Wescom 

8 
 

One selects Track Up or North Up.  North Up is the best choice for most GPS work done on foot. The 

second selects One Color or Multi-Color. Multi-Color is the prettier choice. In making these choices, 

remember that the choice shown in the menu is what the change will be to. When North Up is selected, 

Track Up will be shown in the menu. Likewise, when Multi-Color is selected, One Color is shown in the 

menu. This is a common menu item operation in the GPSMAP 64st. 

Map: In the Map menu, select Setup Menu. In the setup menu select Orientation North Up. Next, select 

Map Information Select Map. In the Select Map map list, only TOPO U.S. 100K need be Enabled. 

Compass: The Compass page is one of the most configurable pages. A number of preconfigured 

Dashboards are provided for specific uses such GeoCashing or driving with Garmin’s City Navigator 

maps loaded.  As a starting configuration I would suggest: 

Dashboard: 

 Small Data Fields 
Data Fields: 

 Time of Day 

 GPS Elevation 

 Battery Level 

 Distance to Next 
 
The Distance to Next field becomes active if you are using the GPS to return to a previous location. A 
large arrow will show up inside the compass pointing the direction to that location. 
(Hint: Navigation can be cancelled by pressing the FIND button and selecting Stop Navigation.) 
 
(For additional compass configuration info see the Heading entry in Configuration Settings below.) 
 
Track Manager: (No change needed.) 
 
Waypoint Manager: (No change needed.) 
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Configuration Settings 
 
There are several settings in the GPSMAP 64st that should be adjusted before it is used in the field. 

These adjustments are made in the Setup menu found on the Main Page: 

System: 

Satellite System: GPS (Using GPS+GONLASS may improve satellite reception in areas with poor 

sky coverage) 

WAAS/EGNOS: On 

Language: (English or other as appropriate) 

Interface: Garmin Serial 

AA Battery Type: (Set as appropriate for the battery type you are using. The GPSMAP 64st 

monitors the battery voltage and uses the battery type info to determine its discharge level. An 

incorrect battery level indication and warning will be given if the wrong type is selected.) 

Display: 

Backlight Timeout: 2 Minutes (Can be set as short as 15 seconds) 

Battery Save: Off (On shuts display off when backlight is off. This is useful to save battery life if 

the GPSMAP 64st will be on to record a track but will be viewed only infrequently. To view the 

display, the power button on the side of the unit is pressed momentarily.) 

Main, Setup, Find Style: List (7 Items) 

Screen Capture: Off 

Map: 

Orientation: North Up. 

Guidance Text: When Navigating 

Data Fields: 0 (You may experiment with this to add information to the Map page display.) 

Advanced Map Setup: (This provides another menu to adjust how things are displayed on the 

map. Set Detail to Most. Set Shaded Relief to OFF for clearer topo map display.) 

Map Information Select Map: In the Select Map map list, only TOPO U.S. 100K need be 

Enabled. Enabling others may slow startup. 
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Tracks: 

Track Log: Record, Show On Map 

Record Method: Auto 

Recording Interval: Normal 

Auto Archive: When Full 

Color: (Whatever you like for this) 

(Note: A later section of this document covers the use of these parameters in more detail.) 

Position Format: 

Position Format: hddd.ddddd (When working with USGS topo maps, hddd.mm.ss.s or UTM UPS 

may be more convenient.) 

Map Datum: WGS 84 

Map Spheroid: WGS 84 

(Note, the GPSMAP 64st does not change its internal location information format when any of 

the three items above are changed. Position information calculated from the GPS satellites will 

continue to be collected in that same consistent internal format. Displayed formats will reflect 

the above choices. Manual Lat/Lon input will be interpreted as in those formats also.) 

Heading: 

Display: Directional Letters 

North Reference: True 

Go To Line (Pointer): Bearing (Large) 

Compass: Auto 

Calibrate Compass: This option invokes a procedure to calibrate the GPSMAP 64st internal 

three-dimension electronic compass. You should move to a large open area that is free of metal 

before beginning this procedure. The GPSMAP 64st displays the instructions for this procedure.) 
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Routing: 

Activity:  Direct Routing (Direct routing provides a compass bearing to a selected waypoint. 

Other selections enable routing on routable maps such as street maps.) 

Calculation Method: Prompted (Allows selection such as shortest or fastest routes on routable 

maps.) 

Lock On Road: No (Only enable for road travel using routable maps.) 
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GPSMAP 64st Use for Beginners 
 

Startup 
When you turn your GPS unit on for the first time, three things must happen before it becomes usable. 

1.  As it is a computer, it must complete its boot sequence. That can take 30 seconds or more. 

2. Next it must search and synch its internal receiver with at least one satellite and download a 

current satellite constellation ephemeris. This can take several minutes. 

3. With that ephemeris available, it can begin synching its receiver with other satellites to calculate 

its own position. This usually takes only a few seconds. 

Restarting the GPSMAP 64st within a few days at the location where it was powered down allows it to 

skip step number 2 above. That makes for a much quicker startup. 

Selecting the Satellite page will provide a view of which satellites the unit is able to receive, their 

positions in the sky, and their signal strengths. This page also shows an indication of the accuracy 

expected with the configuration of satellites currently being received. 

Walking Around 
With the GPSMAP 64st powered on and successfully receiving satellites, it is ready for use. Select the 

Map page to show your location on the internal map. The IN and OUT buttons zoom the map in and out. 

The map may be zoomed in until the distance show from side to side on the display is only about 60 

feet. Maximum zoom out is about 1500 miles from side to side. Display updates become quite slow 

when zoomed out more than 100 miles or so. 

Before using any GPS unit for any serious field work, some familiarization with it is a good idea. 

Fortunately, that consists of little more than taking the unit outside and walking around the 

neighborhood. As you walk along, the position indicator in the middle of the Map page remains fixed 

while the map displayed moves under it. You will also see your track marked on the map. 

The receivers in newer GPS hand held units are very sensitive. The GPSMAP 64st will normally work well 

even inside an automobile, provided that automobile has an open sky above it. To record your driving 

route, simply stand the GPSMAP 64st in a cup holder or similar location. 

Recorded tracks may be managed on the Track Manager page. Tracks may be saved, deleted, and 

archived (moved out of working memory). Those operations are covered in a later section of this 

document. 

While you are moving about, save a Waypoint for practice. This is done by pressing the MARK button. A 

page will pop up on the display allowing you to change the symbol to used to show the location on the 

display, change the Waypoint name, and add notes if you wish. Highlight Done and press the ENTER 

button to finish saving the Waypoint. Waypoint operations will also be covered in more detail in a later 

section of this document. 
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GPSMAP 64st Waypoints 
 

Waypoints are locations you record and store in the device. Waypoints can mark where you are, where 

you are going, or where you have been. You can add details about the location, such as name, elevation, 

and depth. Though simple in concept, they are a very powerful GPS tool. 

The dictionary definition of a Waypoint is ‘an intermediate point on a route or line of travel.’ The term 

came into common use near the end of the 19th century. It is used to indicate a location you must pass 

through before turning onto the next leg of your journey. When navigating an automobile travel route, 

waypoints are typically placed at important highway or street intersections. 

Waypoints have many more uses than indicating locations to head toward on a travel route. Marking a 

location with a Waypoint is much like planting a GPS flag on that spot. Though nothing is physically left 

on the ground, that location information will not be lost for future generations. The quality of historic 

information degrades rapidly. People simply don’t bother recording what they consider every-day 

activities. Knowing the date of a battle, the name of a hero, or the location of a monument tells us very 

little about the world of their times. GPS Waypoints can help slow that loss by supplying the where to 

history stories. 

The GPSMAP 64st can store 5000 Waypoints. That is probably far too many Waypoints to manage on a 

hand held unit intended for field use. It will be comforting to know that you will not have to be 

concerned about hitting a limit when saving Waypoints during field work. 

Creating a Waypoint 
You can save your current location as a Waypoint. 

1. Press the MARK button. 

2. If necessary, select and change a field to change the Waypoint information. 

3. Select Done and press the ENTER button. 

Projecting a Waypoint 

You can create a new location by projecting the distance and bearing from a marked location to a new 

location. 

1. Go to the Waypoint Manager page. 

2. Select a Waypoint and press the ENTER button. 

3. Press the MENU button 

4. Select Project Waypoint and press the ENTER button. 

5. Enter the bearing, select Done, and press the ENTER button. 

6. Select a unit of measure and press the ENTER button. 

7. Enter the distance, select Done, and press the ENTER button. 

8. Select Save and press the ENTER button. 
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Navigating to a Waypoint 
1. Press the FIND button. 

2. Select Waypoints and press the ENTER button. 

3. Select a Waypoint and press the ENTER button. 

4. Select Go and press the ENTER button. 

Ending Navigation to a Waypoint 
1. Press the FIND button. 

2. Select Stop Navigation and press the ENTER button. 

Editing a Waypoint 
1. Go to the Waypoint Manager page. 

2. Select a waypoint and press the ENTER button. 

3. Select an item to edit, such as the name, and press the ENTER button. 

4. Enter the new information, and select Done, and press the ENTER button. 

Deleting a Waypoint 
1. Go to the Waypoint Manager page. 

2. Select a waypoint and press the ENTER button. 

3. Press the MENU button. 

4. Select Delete and press the ENTER button. 
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GPSMAP 64st Tracks 
A Track is a recording of your path. A Track contains information about points along the recorded path, 

including time, location, and elevation for each point. You can think of it as something like a bread 

crumb trail, but very accurate. 

Tracks are handy for marking trails or routes you are travelling. Tracks are easily read from the GPSMAP 

64st by Garmin’s BaseCamp program and other software. Recorded Tracks may then be display in those 

programs. Track data may also be exported by BaseCamp directly to Google Earth or to disk files for 

transfer. 

The GPSMAP 64st does have some specified limits: 

 10,000 points per Track 

 200 saved Tracks 

 2,000 archive Tracks 

10,000 points allowed per Track is unlikely to be a problem. Historic mapping Tracks will likely need no 

more than a few hundred per Track. The track that is being recorded is the Current Track. The Current 

Track can be saved to memory while recording continues. For practical software reasons, there is a limit 

of 200 of those 10,000 point Tracks in working memory. To overcome that limitation (!?), saved Tracks 

can be archived (moved) to main internal storage. Current, saved, and archived tracks can be displayed. 

BaseCamp can read them for display and export. 

Though out of order for this presentation, it is probably a hint worth keeping in mind while reading the 

remainder of this section: To create a clean mapping trace, as when walking a trail, clear “CURRENT 

TRACK” at your chosen track start point. Save the CURRENT TRACK immediately as you complete that 

track. 

Don’t be intimidated by the GPSMAP 64st track system. It will make sense when you start using it. The 

initial step in creating track logs is to set up the GPSMAP 64st track settings.  
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Tracks Settings 
Select Setup > Tracks. 

Track Log 
Turns Track recording on or off. 
Choices are: 

 Do Not Record 

 Record, Do Not Show 

 Record, Show on Map 

“Record, show on Map” is probably the best choice while mapping in the field. However, that 

can quickly clutter your display. “Do Not Record” will minimize clutter and remind you turn 

tracking back on when you intend to use it. “Record, Do Not Show” would be used when 

traveling in an unfamiliar area and might wish to have some means to trace your way back to 

your starting location or later see where you have been without cluttering the display. Track 

Manager options (below) allow you to view or to navigate back on a saved track. 

Record Method 
Sets a Track recording method. 
Choices are: 

 Distance 

 Time 

 Auto 

 Auto records the tracks at a variable rate to create an optimum representation of your tracks. 

Recording Interval 
Sets a Track log recording rate. 
Intervals appropriate for each “Record Method” are selectable. 
Recording points more frequently creates a more-detailed Track, but fills the Track faster. 

Auto Archive 
Sets an automatic archive method to organize your Tracks. Tracks are saved to archive and 

cleared from working memory automatically on the following schedules. 

Choices are: 

 When Full (more than 200 saved Tracks or 10000 points in Current Track) 

 Daily 

 Weekly 

Color 
Changes the color of the track line on the map. 
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Track Manager 
The Track Manager selection in the Main Menu provides operational functions for working with tracks.  

Track Manager top level selections are: 

 Current Track 

 Archived Tracks 

 [a list of saved tracks] 

When one of the above is selected, the following options are provided: 

Current Track 

 Save Track (allows giving the track a text name when saving) 

 Save Portion (allows first and last point to be selected) 

 View Map 

 Elevation Plot 

 Set Color 

 Clear Current Track 

Archived Tracks 

 View Map 

 Elevation Plot 

 Change Name 

 Delete 

 Make Favorite (changes track back to saved status) 

[Saved Tracks] 

 View Map 

 Elevation Plot 

 Show / Hide On Map (toggles between Show and Hide – Show keeps track visible on map) 

 Set Color 

 Change Name 

 Copy Reversed (reverses order of points in track) 

 Delete 

 Archive (Move out of working memory to static storage) 

Most of these options are reasonably self explanatory. View Map has an interesting feature. 

Pressing Menu while on that display brings up a menu with the option: Review Track. That 

review includes distance traveled and number of points in the trace, along with other info. 
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Garmin provided a short list of track operations for quick reference: 

Viewing the Current Track 
1. Select Track Manager > Current Track . 

2. Select an option: 

 To show the current track on the map, select View Map. 

 To show the elevation plot for the current track, select Elevation Plot. 

Saving the Current Track 
1. Select Track Manager > Current Track. 

2. Select an option: 

 Select Save Track to save the entire track. 

 Select Save Portion, and select a portion. 

Note: When a track is saved, an option to clear Current Track is presented to provide a clean 

start for another track. 

Clearing the Current Track 
Select Track Manager > Current Track > Clear Current Track. 

Deleting a Track 
1. Select Track Manager. 

2. Select a track. 

3. Select Delete. 

Navigating a Saved Track 
1. Select FIND > Tracks. 

2. Select a saved track. 

3. Select Go. 

Using Tracks 
Over the years, Garmin has gradually upgraded its GPS product Track capabilities until it is a 

comprehensive system. These units now provide for naming and saving multiple Tracks. However, as 

with most things, more features means an increase in operational complexity. Fortunately, once the 

newer system is understood, it is easy to use. 

The first concept to understand is the Current Track. Whenever Record, Show on Map or Record, Do 

Not Show is selected, the location of the GPSMAP 64st will be recorded in the Current Track. When the 

GPSMAP 64st powered off, recording stops. When it is powered back on, it will continue recording into 

Current Track. If powering off and powering on are not at the same location, the Current Track will 

contain that position difference as just one long track segment and continue recording normally from 

there. 
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While that Current Track operation may be a little confusing at first for historical mapping, it does make 

sense when the GPSMAP 64st is used for extended hiking or camping activities. Powering the unit off to 

save batteries while remaining at a single location for hours or days without losing the past travels could 

be handy.   

There are three options for saving tracks for research purposes: 

1. Standing at the start location of a Track you wish to record, delete the existing Current Track. 

(See Clearing the Current Track above.) Begin walking or driving your Track. Immediately upon 

reaching the end of your Track, save the Current Track. (See Saving the Current Track above.) 

2. Simply save the Current Track using the Save Portion option. This option allows you to specify 

beginning and ending points of the Track you wish to save. This should be practiced before it is 

attempted in the field. It may be difficult to identify those desired beginning and ending points. 

3. Clear or save and clear the Current Track at the beginning of a mapping session. Travel the 

intended track or tracks. Save the Current Track at the end of the mapping session. Edit the 

saved Current Track in Base Camp or other mapping software. This also requires practice but it 

has the advantage that it can be done sitting at a desk, indoors. 

When working with Tracks in programs such as Base Camp, it is possible to make safety copies of Tracks 

before modifying them. Copy the Track to a separate Base Camp folder and rename it. If you damage 

the Track beyond repair while editing it, you may delete that working copy and start over with a fresh 

copy. 

Even when Track recording is not planned for a day’s mapping work, having a record of the days travels 

may be useful. While the GPS unit will provide precise location information in the field, viewing those 

travels as a trace on a map can provide context. A set of recorded Waypoints can be difficult to 

interpret, even for the person who recorded them, without a reminder of the day’s travels. 

As mentioned above, mapping programs typically allow for creating a Track. Individual Waypoints and 

recorded Track segments may not be adequate to convey the entire path of a trail or road. An artificially 

drawn Track can show a complete path unambiguously. This allows that information to be saved in a 

format that can be transferred between programs in GPS data format. 

  



11/24/2018 GPS for Historical Mapping Spangler, Wescom 

20 
 

Garmin Software 
 

Using a hand held GPS unit to collect waypoint and track information is only half the historic mapping 

job. Actually it may be significantly less than half. History is about documentation for further study and 

review. Fortunately Garmin and other companies supply software for reading data in a GPS unit and 

saving it a PC for further work. Garmin’s program is named BaseCamp and is available free on Garmin’s 

web site. 

Once you have BaseCamp installed and running, you may connect the GPSMAP 64st to your computer 

via the supplied USB cable. Base Camp will automatically detect the GPS unit and display its internal 

storage. BaseCamp will also begin copying the TOPO U.S. 100K map to your PC for display. That map will 

be available in BaseCamp whenever you connect the GPS unit. 

The folder listing will show a Devices section. Your GPSMAP 64st will show up in the Devices list. When 

you click on its Internal Storage folder, a list of saved waypoint, tracks, and routes will show up below. 

You may click on any of the Internal Storage items to have it displayed on the BaseCamp map. 

A word of warning though, though Internal Storage is displayed by BaseCamp, that data is not 

automatically saved in the PC. That must be handled manually. Create a folder in My Collections in the 

Library area. Name the folder something appropriate for your project. Click on Internal Storage again to 

open that folder. Click-slide-and-drop Internal Storage entries into your new folder. Those entries will 

remain available in the GPS unit until explicitly deleted from there.  See the “Retrieving and Saving 

GPSMAP 64st Data” chapter for a more detailed description of this process. 

Note: You may also use that Click-slide-and-drop process to move things into your GPS unit. 

Once you have your data saved into your PC you may begin the cartographic part of the work. 

Waypoints and Tracks may be renamed to provide more explicit or mnemonic explanation of their 

purpose. Redundant and mistaken Waypoints may be deleted. Unnecessary parts of Tracks may be 

trimmed off. Waypoints may be added along recorded tracks to provide a more complete Waypoint list 

for a trail or road. 

A feature worth considering in mapping programs is Track creation. Individual Waypoints and Track 

segments may not be adequate to convey the path of a trail or road. An artificially drawn Track can 

show a complete path unambiguously. 

When a clean set of data is available, it may be presented on computer screens or printed to hard copy. 

Waypoint and Track symbols, sizes, colors, and opacities will likely need adjusting – on a point by point 

basis – for desired image clarity and impact. 

That data may also be exported to disk files for use or processing by other programs. BaseCamp has 

limited export flexibility but other free or low cost software can translate those files in a number of 

different formats. 
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Enhancements: 
The functionality of BaseCamp can be improved with some simple add-ins: 

BirdsEye: 

 One add-in of interest is the Garmin BirdsEye aerial photograph add in feature. BirdsEye allows users to 

download aerial photographs directly into BaseCamp. Though Garmin’s server limits image size, images 

blocks several miles on a side may be downloaded. 

BirdsEye aerial photographic images may be turned on and off while work with GPS data. This feature 

will allow ground image verification of data editing work. Occasionally, the topographic map 

presentation in BaseCamp may not provide sufficient clarity in map location versus true physical 

location. BirdsEye image downloads are free for the first year of GPSMAP 64st ownership. 

OpenStreetMap: 

An option worth considering is adding street and road maps to BaseCamp. Garmin provides its Garmin 

City Navigator products. City Navigator North America is priced at $80. This product is map data that is 

loaded into Garmin’s street map products but does not include the highway intersection graphics. For 

Historical Mapping functions however, the Garmin product may be overkill. 

The OpenStreetMap project provides free, high quality, road maps. The OpenStreetMap project is user 

supported for both mapping updates and funding. Both wide area and individual state maps are 

available for download. Maps are available in both BaseCamp add in and GPSMAP 64st loading formats. 

These maps are routable. That is, given as starting and ending location, both BaseCamp and GPSMAP 

64st can calculate a route between them and supply turn by turn travel information. These maps are 

available at: http://garmin.openstreetmap.nl/ 

Both downloaded BirdsEye images and OpenStreetMap maps are operable without the GPSMAP 64st 

connected to the PC. 

  

http://garmin.openstreetmap.nl/
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Retrieving and Saving GPSMAP 64st Data 

Concept: 
Data collected with a Garmin GPSMAP 64st as part of a historical mapping effort should be preserved for 

analysis and processing. First, and foremost, the raw collected data must be retrieved and placed in 

secure storage. Next, a working copy of that data should be created. The raw data storage will be 

available for correcting any errors that might occur while removing redundant or erroneous waypoints 

or tracks. 

Retrieving data from a GPSMAP 64st is both simple and safe. Reading the GPS data is accomplished by 

connecting the unit with a USB cable to a PC running Garmin BaseCamp.  Reading the GPS data with 

Garmin BaseCamp and other similar programs does not delete the data on the GPS unit. Deletion is 

done with BaseCamp using an explicit delete command. 

Reading GPS Data: 
Reading the current data stored in a GPSMAP 64st is easy. Start Garmin BaseCamp and connect the 

GPSMAP 64st supplied USB cable. BaseCamp will discover that the unit is connected. It will show up in 

the folder listing at the left side of the map in a category labeled “Devices.” 

Though waypoints, tracks, and even maps show in BaseCamp, the GPSMAP 64st data is not yet in the PC. 

It is being read from the 64st internal memory. That data may be examined and displayed on the 

BaseCamp map. Disconnecting the 64st will cause its data folders to no longer be available in BaseCamp. 

The GPSMAP 64st data will remain on the unit. 

Saving the Raw GPS Data: 
Saving GPS data in the PC requires that be copied from the GPSMAP 64st to a PC folder. If not already 

done, a folder should be created to contain the PC copy of the data. 

To create your project folder in BaseCamp: 

1. Right click on “My Collection” in the folder box to the left of the map in BaseCamp. 

2. Select “New List Folder” and enter your project name. 

3. Right click on your new project folder. 

4. Select “New List” and name it “RAW.” 

To copy GPSMAP 64st data to the RAW folder:  

1. Connect the GPSMAP 64st to the PC via the USB cable (with BaseCamp running). 

2. When the GPSMAP 64st shows up in the folder list at the left of the map, select its “Internal 

Storage” folder. 

3. Highlight the Waypoints shown in the item listing below the folder list box and copy those them 

to your “RAW” folder. 
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4. Do as with step 3 above with tracks (indicated with footprints). 

To Back Up Your RAW data: 

1. Highlight your project “RAW” folder. 

2. At the top of the BaseCamp window, select “File” -> “Export” -> “Export ‘RAW’”. 

3. Save “RAW.gpx” to a safe location on the PC or to a thumb drive for future reference. 

At this point you have two copies of your raw GPS data, plus what is on the GPSMAP 64st. You may 

delete individual waypoints and/or tracks from the GPS unit to unclutter it. You may do this using 

BaseCamp if you wish. That is often easier than manually deleting waypoints and tracks using the units 

buttons. 

The GPSMAP 64st may now be disconnected from the PC. 

Future additional waypoints and tracks can be added to your RAW folder from the GPS unit as described 

above. The new combined list can also be exported to a “.gpx” file as described above. 

Note: The “.gpx” file suffix indicates it is a standard GPS data exchange format file. This type of file is 

recognized by most GPS mapping software. 

Working With GPS Data from RAW folder: 
GPS data should never be modified or deleted from your RAW folder. Create a working folder in your 

project folder. Copy desired Waypoints and/or Tracks from your RAW folder to your working folder. 

Once in your working folder, waypoint names may be changed to be more descriptive. Tracks may be 

renamed, corrected, or simplified. Once those data items are set, they may be adjusted for appropriate 

display characteristics such as size, color, and shape. 

Your working folder may also be exported as a “.kml” for safety or version control. This cleaned up 

“.kml” version of the GPS data may be imported into Google Earth for additional adjustment and 

display. Export to “.gpx” is a common format for other programs such as ExpertGPS. 

As a side note, programs such as Google Earth and ExpertGPS can also directly read data from the 

GPSMAP 64st. Garmin GPS products are well supported by mapping software.  

Transferring GPS Data to Other Software: 
BaseCamp is able to export GPS data in a variety of formats if necessary. This allows flexibility in 

accommodating data transfers to agencies with preferences other than “.kml” format. 

Those choices are: 

GPS eXchange Format (*.gpx) 
KML 2.2 Document, v2 (*.kml) 
Comma-delimited text (*.csv) 
Tab-delimited text (*.txt) 
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KML format is often used by map creation software. Software is available to converting these formats to 

yet others. As an example, the ExpertGPS program can export GPS data in the above formats as well as 

the following: 

Topo! File (*.tpg) 
Maptech Mark File (*.mxf) 
Point Shapefile (*.shp) 
CAD DXF (*.dxf) 
GeoJSON File (*.geojson, *.json) 

 

Should the need arise to provide GPS data in a format not shown above, a number of GPS data file 

format converters may be found on the web, often free. For example, the program “DNRGPS” is 

available free for converting Garmin data and KML files to ESRI Shapefile vector GIS data format. 

Summary: 
The key point to remember is that reading data from a GPSMAP 64st does not cause it to be deleted. 

Proper research procedure requires that raw data be preserved for future reference. A separate copy of 

that data should be used as working data. It is common that some waypoints are redundant and some 

simply invalid. Tracks are especially likely to need deletion or editing. They often show how a search for 

a location or path involved moving about to find it. Some tracks may simply need to be redrawn. Most 

mapping tools allow for that. 

Once GPS data is collected, it must be preserved. That data often must be cleaned and polished for 

further use but that work must be performed on a copy of original collected data. Even then, how it is 

packaged will vary depending upon its final use. Fortunately, Garmin GPS hardware is so common that 

many tools are available for assistance meeting your ultimate mapping goals. 
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Editing GPS Data with BaseCamp 

Why Editing is generally necessary: 
Raw field collected GPS data will normally contain erroneously created Waypoints and Tracks with 

unnecessary or incomplete segments. This is simply a reflection of the effort involved in mapping field 

work. It is often best to mark a location of questionable importance in case further research proves it 

otherwise. Deleting or correcting data later is easy. 

Another purpose for editing GPS data is to insert information not available from a field mapping effort. 

This information may have been obtained using aerial photographs or other maps. Inserting data that 

was not directly collected with a GPS unit is a valid approach historical mapping. It must, of course, be 

used with caution. In all cases, editing of GPS data should be done to increase its accuracy and clarity. 

BaseCamp does have one disadvantage over more sophisticated mapping software. It cannot convert 

Tracks into Shapes as used in some cartographic software. However, BaseCamp may be a preferred way 

to edit GPS data. Exporting BaseCamp edited data to third party a mapping program such as ExpertGPS 

can provide that conversion. (See Editing With ExpertPGS below.) 

Why Edit With BaseCamp? 
BaseCamp’s cartographic capabilities are optimized for showing how to get to a location. In other 

words, its design is optimized for inserting location and routing information into a GPS unit, not mapping 

data collected by the GPS unit. As a result, BaseCamp’s ability to edit GPS data, both created in 

BaseCamp and collected from a GPS unit, is extensive. BaseCamp may be used as the data editing and 

management tool for use in other mapping software for display or printing. 

Editing GPS data in BaseCamp: 
The first thing to keep in mind while editing Waypoints and Tracks in BaseCamp for display is that there 

is limited ability to change Icon  colors, line widths, and other similar display features. BaseCamp is 

designed as a multipurpose tool with greatest emphasis on routing between locations on roads and 

trails. High quality cartographic formatting was not part of its original design.  

There is a feature in BaseCamp editing that can help with fine detail work while editing Waypoint 

locations and Track paths. This is easier when aerial photographs of map areas may be used for 

comparison. Consider adding Garmin BirdsEye aerial photo images as described in the Enhancements 

part of the Garmin Software section above. Those photographic images may be toggled on and off as 

needed. 

One handy feature of for using the BirdsEye images is that the action menu that is provided when right 

clicking on a Waypoint or Track contains and entry labeled “Create BirdsEye Image…”  This selection 

allows you to size a rectangle over the area and download it from the Garmin server. (Remember that 

the GPSMAP 64st must be connected to the PC to use the one year free BirdsEye service.) 
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Waypoints 

Waypoints may be deleted, moved, or created in BaseCamp. Deleting erroneous or redundant 

Waypoints is probably the most common edit operation. Waypoint creation from examination of aerial 

photographs or latitude/longitude obtained from other sources is possible. 

A Waypoint is edited by right clicking on either its map icon or its entry in its folder listing. A menu will 

pop up with a series options. The options of most interest are: Open, Move Waypoint, Delete, and 

Create BirdsEye Imaging. 

The Open selection pops up a properties dialog allowing the icon and text label to be changed. Changes 

to icons will typically not be carried through to other software. Text labels and notes generally are 

passed along. 

Tracks 

Track editing is one of the more useful features of BaseCamp. Individual Track Points may be deleted or 

moved to remove casual or unimportant side trips from a Track. Editing individual Track Points can be a 

bit tedious but it will provide fine adjustment of a Track’s path. 

 Tracks may be split into two or more separate smaller Tracks. This is particularly handy for dealing with 

all-day Tracks. That is when tracking is turned on when first reaching the field and left on until time to 

return to the office. That long Track can be broken into smaller parts can be saved or deleted as needed.  

Editing a Track is similar to editing a Waypoint in that a right click on a Track or Track Point will provide 

an action menu. The action menu for a Track includes Open, Delete, and Create BirdsEye Imagery. The 

action menu for a Track Point includes the additional items Split Track Here, Split Track at Segment, 

Insert into Track, Move Track Point, and Delete Track Point.  

A word of caution: The action menu items labeled Delete and Delete From- with the leading X icon 

deletes the entire Track even in the Track Point action menu. 

Selecting Open allows editing of a Track’s name. Some mapping programs show the name along a Track 

on displayed or printed maps. 

To split a Track, bring the Track into view on the screen. Zoom the Track until individual Track points are 

visible. Right click on a trackpoint where you want a split. Select Split Track Here or Split Track at 

Segment. Split Track breaks the Track at the specific point but both resultant Tracks contain an identical 

point. Split Track at Segment leaves a gap with the next point along the original Track as the beginning 

point of the new Track segment. 

Individual trackpoints may be moved within a Track while the Track is selected. Hold the Alt key down. 

Move the trackpoint by clicking and holding the right mouse button. Release the mouse button. Then 

finally release the Alt key. 
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Adjusting Waypoint and Track Display 
BaseCamp’s limited adjustments of Waypoint and Track display is accessed by editing Display Options. 

This is accessed via Edit -> Options -> Display Options. Waypoint size is adjusted with the Symbol Size 

slider. Track line thickness is adjusted with the Track Width slider.  

Display parameters, however, are not reliably transferred to other programs such as Google Earth or 

ExpertGPS. These other programs have their own specific display parameters that do not always match 

up with BaseCamp’s. 

Mismatch in display parameters when transferring data from BaseCamp does not mean BaseCamp is 

not useful as an editing tool. Overall, its Waypoint and Track editing capabilities are significantly more 

flexible than many other mapping programs. BaseCamp is a good choice for cleaning and adjusting GPS 

data. Once imported into other programs, work then is properly displaying the data.  
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Editing GPS Data in Google Earth 

Concept: 
One potential option for providing graphic display of data gathered with the GPSMAP 64st is with the 

use of Google Earth. The obvious advantage of Google Earth is that it is free and available on essentially 

every PC. Additionally it provides a mechanism to view GPS data as aerial photographs at variable scale 

and detail. 

As with Garmin’s BaseCamp, Google Earth can read GPS data from a GPSMAP 64st. Google Earth could 

be used as a standalone GPS data editor and display system. However, Google Earth is targeted more 

for displaying GPS data on its aerial photo images than editing it. Moving, deleting, and adding 

Waypoints is straightforward. The steps used to split or modify Tracks are somewhat obscure. 

It should be emphasized that transforming raw GPS data into attractive graphic presentations is a skill 

that requires practice and patience to acquire. Fortunately, what is needed for GPS data display is 

straightforward. The goal is simply to present GPS data in a form appropriate for the intended venue. In 

historical circles, it is typically the information content of the data, not its form that matters. 

Waypoints 

Waypoints may be deleted, moved, or created as in BaseCamp. Google Earth provides extensive editing 

capability of Waypoint parameters such as icon type, color, size, transparency, and name font and size. 

An individual Waypoint can be edited by right clicking on it and selecting the Properties option.  The top 

line of the Properties dialog provides for editing the name and icon. The Style, Color tab provides for 

adjusting the color, size, and opacity of both the name and the icon. 

To group modify all Waypoint properties, edit the first Waypoint in a list. You may select it by right 

clicking on it in the list. Set its icon, and the color, size, and opacity for names and icons. That provides 

the prototype for the group modification. Right click on the ‘Waypoints’ folder line. Select the 

Properties entry. In the Properties dialog, click on the Style, Color tab. Google Earth will notice that not 

all waypoints have the same properties and provide a button to make them the same as that first 

Waypoint entry. 

Tracks 

Operations such as splitting or modifying a Track in Google Earth are not as easy as with Garmin’s 

BaseCamp. Spitting a Track requires that the project be saved by Google Earth as a “.kml” file that must 

then be manually edited with a text editor such as Microsoft’s Notepad. 

Deleting or moving individual GPS points along a Track may be done by right clicking a Track in its Track 

folder in your project’s Tracks folder. (That is: [project name] -> Tracks -> [track name] -> Track) and 

select Properties.  Individual Track points may be moved, added with a left click, and deleted with a 

right click. I may take practice to become comfortable with this process. 
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As with Waypoints above, a Track Properties dialog allows you to adjust its display characteristics. The 

Style, Color tab allows adjustment of Track line color, width, and opacity. Track Points are handled 

separately and are normally left with Zero opacity. Group modification of Track display properties may 

be performed as described for Waypoints above. 

Finalizing View in Google Earth: 
A completed project may be saved as a “.KMZ” file. To create this file, right click on the project folder in 

the Places listing. Choose "Save Place As....". Save your folder as a ".KMZ" format file. This file can be 

imported to Google Earth on other computers for display. 
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Editing GPS Data in ExpertGPS 

Concept 
Garmin’s BaseCamp and Google Earth are both free programs. Both allow extensive GPS data editing 

and display capabilities. Neither is designed specifically for cartography. Software is available that is 

oriented toward producing professional quality maps. The majority of this software, however, is 

expensive, often priced in the $5,000 to $20,000 range. Less expensive but adequately capable software 

is also available. One example of this less expensive software is ExpertGPS for $250.  

ExpertGPS is specifically designed for producing maps. It can show GPS Waypoints and Tracks on 

topographic, aerial photo, and road maps. It also allows use of scanned maps. It also allows adding, 

deleting, and editing of both Waypoints and Tracks. ExpertGPS can read GPSMAP 64st data and operate 

as a standalone editing, display, and map printing package.  

Waypoints 
Waypoint editing is facilitated with two symbols in the tools bar above the map area. The tool used to 

create Waypoints is a small circle with four short lines radiating outward. The “Move Selected Tool” (a 

cross with a small arrow pointing up and to the left) is used to select and move or edit an existing 

Waypoint. To edit the characteristics of a Waypoint, right click on it with the selection tool.  

Tracks 
Track editing is somewhat obscure compared with Waypoint editing. Tracks may be moved as a unit 

using “Move Selected Tool”. 

Individual trackpoints may be deleted but not move with respect to other points in the Track. To delete 

a trackpoint, double click on the Track containing the point to be deleted. Select “Trackpoint List.” 

Locate the point to be deleted by clicking on entries in the Trackpoint List. Once the point is located, 

right click on the point’s entry to select “Delete Point.” 

To split a Track, follow the same sequence as for deleting a point but select “Split Track.” 

Notes 
ExpertGPS includes a data type not available in BaseCamp. It an object named Note. It is useful for 

adding descriptive text blocks to maps. Notes are similar to Waypoints except they do not carry any GPS 

data collection information. While Notes differ from Waypoints, the both allow for displayed text and a 

map symbol. When used as a text block without a symbol, its “Text Position” should be set to “Above 

Marker” to provide an easily located handle to move it if necessary. 

 Note and Waypoint movement is done by selecting its symbol, visible or otherwise. 

Shapes 
One key additional object type is the Shape. Waypoints and Tracks are most associated with navigation 

and GPS use. Notes and Shapes are used in cartography, especially with GIS.  ExpertGPS allows 

conversion between the two representation methods. 
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A Shape is a two dimensional object of arbitrary size and shape. When converted by ExpertGPS, a Track 

becomes line Shape. The difference between a Track and a Shape is that the Track contains GPS 

collection information while the Shape does not. 

Waypoint, Track, and Note Display Parameters 
ExpertGPS provides a variety of symbols to be used with Waypoints and Notes. Those symbols and 

colors are not, however, individually set for each object. The same is true for line colors and widths for 

Tracks and Shapes. These parameters are set by an object’s configuration “Type.” That is the top entry 

when editing an object.  Configuration “Types” are separate for Waypoints, Notes, Tracks, and Shapes 

even when identical “Type” names are used in each. 

Waypoint and Shape configurations include selecting a symbol or none and descriptive text if any. Both 

allow adjustment of text size but not symbol size. How text is displayed is determined by settings in the 

“Map Display Options” dialog found under “Options.” Drop shadow and background can be adjusted 

including None, Transparent, Opaque, and Framed. Text and position of that text relative to its symbol 

(even if invisible) is set separate for individual Waypoints and Shapes. Waypoint text labels may be 

turned off if desired. Their text size can be set to “Hide.” 

Track and Shape configurations include color, width, opacity, and whether it has a border. A text label 

may be added for display alongside the displayed path. 

General File Considerations 
Waypoint/Track vs Note/Shape: As mentioned above, Waypoints and Tracks are associated with 

navigation and GPS data. However, commercial mapping systems and GIS primarily use Notes and 

Shapes. This differentiation is of little concern unless data is to be transferred in disk file form to other 

agencies. Fortunately ExpertGPS is able to create data files in a number of different formats. If a file 

format has not been specified when transferring GPS data to other agencies, the likely safest format is 

Google Earth “.KML” with Waypoints and Tracks converted to Notes and Shapes. 

Printable map format: While ExpertGPS can directly print maps, it is often desirable to insert them into 

other documents. PC systems typically provide a method to print to a file. Microsoft Windows normally 

provides “Microsoft Print to PDF” printer option. Programs such as Microsoft Word allow the resulting 

“.pdf” file to be directly inserted into a document.  However, the direct “.pdf” insert does not always 

provide optimal image resolution. 

Significantly improved image resolution of inserted “.pdf” maps can be achieved by first converting that 

“.pdf” to a “.png” (Portable Network Graphics) lossless image file. “PDF to JPG” (Trisun Software) is an 

inexpensive utility that can do this. “PDF to  JPG” is flexible, capable of a variety of conversion formats 

and resolutions. 300 Pixels/Inch is adequate for typical 8.5 by 11 Word documents. Higher resolution 

might be preferred for magazine or book imaging. 

Finalizing View in ExpertGPS 
A completed project may be saved as a “.gpx” file using the familiar File -> Save As method. Be sure to 

use a descriptive filename. Consider including the file date in the name as file dates and times are often 
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lost during transfer from one machine to another. Actually, project data should be saved periodically 

through its development. That past saved data will provide both a record to the project progress but 

also a backup if the current work is lost. It is easier to recover a project from the previous day’s work 

than from last month’s! 

 

  


